
Elluminate is the web and teleconferencing application used by CCC Confer to provide a communications option

for faculty and staff within the California Community College System. Elluminate boasts powerful tools for online

and telephone meetings, and accessibility is included. Elluminate supportsoperating system-specific settings

related to accessibility, as well as popular assistive technology products. In addition, Elluminate also provides a

means for displaying closed captions when available, and allows each user to configure their workspace as best

suits thir needs. By using the built-in features of Elluminate in conjunction with the best practices for designing and

delivering web based instruction, you have the ability to provide effective and accessible synchrounous instruction.
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There are several ways to enhance the visual presentation of information within CCC Confer's Blackboard

Collaborate, both on the transmitting and on the receiving side of the experience.

For students with visual impairments who are using CCC Confer's version of Blackboard Collaborate, it is

important to recognize the availability of the built-in assistive technology of their operating system. Windows and

Mac OS X both provide basic tools that can be used to make the computer environment more accessible.

Blackboard Collaborate takes advantage of these capabilities and allows for the operating system to determine

what the visual scheme will be.

Microsoft Windows Ease of Access Control Panel

When students with visual impairment utilize screen magnifiers to enlarge or change the color scheme of the

computer display, Blackboard Collaborate will continue to provide interactive text chat, video, whiteboard, and

desktop sharing. Changing the system's visual settings or starting assistive technology applications while

Blackboard Collaborate is in mid session can produce undesirable results. It is advised (and expected) that

students will have their assistive technologies and system configuration settings in place before launching

Blackboard Collaborate. When students are using assistive technology or custom display configurations, they can

safely launch and use Blackboard Collaborate.
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Example of Blackboard Collaborate running under a High-Contrast system setting.

The Blackboard Collaborate interface itself is configurable to several pre-defined settings, or the end-user can

customize which components to view and what size they want them to be. When a user creates a custom interface

layout, Blackboard Collaborate will remember this layout the next time they logon to the system. This allows each

user to specify the type of interface they will have, according to their needs and desires. To access the pre-defined

layout options within Blackboard Collaborate, start with the "View" menu, and then select "Layouts", and choose

from the following options: Default Layout, Wide Layout, Tall Layout, Narrow Minimal Layout, Flat Minimal Layout,

Left Docked Minimal Layout, Right Docked Minimal Layout, and Whiteboard Only.
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Blackboard Collaborate Interface View Configuration Options

Blackboard Collaborate Wide Layout Interface Example
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Blackboard Collaborate Whiteboard Layout Interface Example

Blackboard Collaborate Custom Layout Interface Example

It is important to note that in order to be able to resize the individual component windows for a custom layout in

Blackboard Collaborate, one must first ensure that the Layouts are not locked. From within the "View" menu of the

Blackboard Collaborate interface, check to see that the "Layouts Locked" option is not checked to ensure the

layouts are not locked.

Finally, it is important to note that for students who are blind and using a screen reader to access Blackboard

Collaborate, they will have to first install the Java Accessibility Bridge.Once this has been installed Blackboard
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Collaborate can be used with modern screen reading applications. Check the Resources section on CCC Confer

for more information on Accessibility and Screen Readers.

On the other end of things is the ability and need to provide the largest and easiest to see presentations possible,

so as to give everyone a decent chance at seeing what is going on. Blackboard Collaborate allows you to specify a

custom presentation size, called "Screen Size" for your presentations. You can select from a variety of pre-defined

resolutions, or you can choose your own custom settings. In addition to specifying screen sizes for your

presentations, Blackboard Collaborate allows you to enlarge images placed on the whiteboard by selecting them

and using the resizing tools to enlarge the image.

Blackboard Collaborate Specify Import Screen Size Dialog
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CCC Confer's Blackboard Collaborate System provides a Closed Captioning icon in the top menu bar

that allows for deaf and hearing impaired users to receive captions when they are available.

It is important to remember that captions must be specifically requested when you request your Blackboard

Collaborate session. A captioner will be provided for your session and all participants in the session will have the

option to display the captions or not. Closed Captioning will be retained in archived sessions so that students can

always have access to the information. Additionally, the captions can be saved as text files for later use and review

outside the Blackboard Collaborate session. The Closed Captions in Blackboard Collaborate can be enlarged as

well, up to 32 points.

In addition to the Closed Caption capability, students who are deaf or hard of hearing can utilize the text chat area

to participate in conversations and ask the instructor questions.

The "Participants" dialog provides an overview of the Blackboard Collaborate session participants, and will provide

a visual indication when someone is using audio, and can be used to communicate other standard crowd

responses.

Blackboard Collaborate Participants Window
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As a modern electronic information and communications system, Blackboard Collaborate meets the 508 criteria for

accessibility including keyboard operability. Keyboard operability allows for students who can't use a mouse to

operate and interact with the Blackboard Collaborate system. These keyboard commands are useful for everyone,

regardless of disability.
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Application Sharing

When using application sharing, take snapshots of the application and send it to the whiteboard pressing Ctrl +

Print Screen from time to time.

If you are sharing moderator privileges, you can take back control of the presentation by pressing Ctrl + Space

Bar.

To terminate application control, press Ctrl + Pause.
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Audio and Video Communication

Press & Release the Talk button = Ctrl + F2

Start & Stop video transmission = Ctrl + F3
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Chat Commands

Chat = Ctrl + m

Laughter emoticon = Alt + 1

Applause emoticon = Alt + 3

Confusion emoticon = Alt + 4

Disapproval emoticon = Alt + 6

Hand Raise = Ctrl + R

Poll Response Yes = Ctrl + 1

Poll Response No = Ctrl + 2

(Note: These key commands will lend themselves nicely to a table layout once inside Moodle)
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Complete Keyboard Command List

Function
Windows, Linux

Keystroke
Mac Keystroke

Quit Blackboard Collaborate
Alt+F4

Ctrl+Q
Command-Q

Hide Blackboard Collaborate Command-H

Hide other applications Command-Option-H

Close window (Notes, File Transfer, Activity, Closed-Captioning, Session

Plan, Quiz, Multimedia, Calculator)

Alt+F4

Ctrl+W
Command-W

Switch to Whiteboard Mode Ctrl+Alt+W Command-Option-W

Switch to Application Sharing Mode Ctrl+Alt+A Command-Option-A

Switch to Web Tour Mode Ctrl+Alt+U Command-Option-U

Move to the next main module in the user interface. The default order is

Audio/Video panel, Participants panel, Chat panel and Collaboration

toolbar. (If you change the order of the panels, the order will change.)

F6 F6

Open the Action bars of Whiteboard Mode and Web Tour mode F6 F6

Move to the previous main module in the user interface. (See F6 above for

the order of modules
Shift+F6 Shift-F6

Move to the next user interface element (e.g., button, field, option) in in a

main module or UI element. (For example, if focus is in the Collaboration

toolbar, Tab and Shift-Tab can be used to move between the three modes

(Whiteboard, Applicaton Sharing and Web Tour), the Information menu,

the Load Content button and the Record button)

Tab Tab

Move to the previous user interface element (e.g., button, field, option) in a

main module (see example for Tab above)
Shift+Tab Shift-Tab

Activate the currently selected function Space Space

Enable tabbing in toolbars of secondary windows (Closed Captioning,

Notes, Activity Window, File Transfer, Session Plan, Quiz, Multimedia)
Alt+F8 Option-F8

Move keyboard focus between open windows (Notes, File Transfer,

Activity, Closed-Captioning, Session Plan, Quiz, Multimedia, Calculator)

(For Windows machines, Alt+F6 only works on Windows XP)

Alt+F6 Command-`
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Function
Windows, Linux

Keystroke
Mac Keystroke

Open Options menu of the panel or toolbar in focus (Audio/Video, Chat,

Participants, Whiteboard action bar, Whiteboard navigation bar or Web

Tour)

Ctrl+Shift+O Command-Shift-O

Open Preferences dialog box Ctrl+Comma Command-Comma

Create new Quiz, Whiteboard page or Whiteboard page group Ctrl+N Command-N

Open Multimedia file, Quiz, Session Plan, file for transfer or Whiteboard

presentation
Ctrl+O Command-O

Save Participants List, Chat conversation, Quiz, Session Plan or

Whiteboard
Ctrl+S Command-S

Print Participants List, Session Plan or Whiteboard Ctrl+P Command-P

Open Activity Window Ctrl+/ Command-/

Close Activity Window

Ctrl+/

Alt+F4

Ctrl+W

Command-W

Press the Talk button (Note: this is a Hot Key) Ctrl+F2 Control-F2

Release the Talk button (Note: this is a Hot Key) Ctrl+F2 Control-F2

Adjust microphone level down
Ctrl+Shift+Down

Arrow

Command-

Shift-Down Arrow

Adjust microphone level up
Ctrl+Shift+Up

Arrow

Command-Shift-Up

Arrow

Adjust speaker level down
Ctrl+Alt+Down

Arrow

Command-

Option-Down Arrow

Adjust speaker level up Ctrl+Alt+Up Arrow
Command-

Option-Up Arrow

Start Video transmission (Note: this is a Hot Key) Ctrl+F3 Control-F3

Stop Video transmission (Note: this is a Hot Key) Ctrl+F3 Control-F3
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Function
Windows, Linux

Keystroke
Mac Keystroke

Switch to Whiteboard Mode Ctrl+Alt+W Command-Option-W

Select all objects in Whiteboard Ctrl+A Command-A

Open Page Explorer window Ctrl+Shift+P Command-Shift-P

Open Object Explorer window Ctrl+Shift+T Command-Shift-T

Copy selected object(s) or text in Whiteboard Ctrl+C Command-C

Cut selected object(s) or text in Whiteboard Ctrl+X Command-X

Paste copied or cut object(s) or text to Whiteboard Ctrl+V Command-V

Group selected objects Ctrl+G Command-G

Group selected objects and send to background Ctrl+B Command-B

Ungroup selected objects Ctrl+U Command-U

Delete selected object(s) or text in Whiteboard
Delete

Backspace

Delete

Backspace

Go to next page Alt+Page Down Option-Page Down

Go to previous page Alt+Page Up Option-Page Up

Move to first page at this topic level Alt+Home Option-Home

Move to last page at this topic level Alt+End Option-End

Send Application Sharing snapshot to Whiteboard (Note: this is a Hot Key)Ctrl+Print Screen Control-F13

Take back control of Application Sharing (Note: this is a Hot Key) Ctrl+Space Control-Space

Stop Application Sharing (Note: this is a Hot Key) Ctrl+Shift+S Control-Shift+S

Move cursor to the Message text box of the Chat panel Ctrl+M Command-M

Select all Chat text in conversation pane Ctrl+A Command-A

Copy selected Chat text in conversation pane Ctrl+C Command-C

Paste copied Chat text to Chat Message text box, Whiteboard or external

application
Ctrl+V Command-V
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Function
Windows, Linux

Keystroke
Mac Keystroke

Raise or lower your hand Ctrl+R Command-R

Show that you have stepped away or come back Ctrl+Shift+A Command-Shift-A

Show smiley face Alt+1 Option-1

Show LOL Alt+2 Option-2

Show applause Alt+3 Option-3

Show confusion Alt+4 Option-4

Show approval Alt+5 Option-5

Show disapproval Alt+6 Option-6

Show Slower (when you want the presenter to slow down) Alt+7 Option-7

Show Faster (when you want the presenter to speed up) Alt+8 Option-8

Show None (when you want to clear all displayed emoticons) Alt+0 Option-0

Open Notes window Ctrl+E Command-E

Close Notes window
Alt+F4

Ctrl+W
Command-W

Go to the next item Ctrl+] Command-]

Go to the previous item Ctrl+[ Command-[

Close Session Plan window
Alt+F4

Ctrl+W
Command-W

Start or stop recording Ctrl+Shift+R Command-Shift-R

Add recording index entry Ctrl+Shift+I Command-Shift-I

Open Closed-Captioning window Ctrl+F8 Command-F8
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Function
Windows, Linux

Keystroke
Mac Keystroke

Close Closed-Captioning window
Alt+F4

Ctrl+W
Command-W

Yes - polling response Ctrl+1 Command-1

No - polling response Ctrl+2 Command-2

A - polling response Ctrl+1 Command-1

B - polling response Ctrl+2 Command-2

C - polling response Ctrl+3 Command-3

D - polling response Ctrl+4 Command-4

E - polling response Ctrl+5 Command-5

None Ctrl+0 Command-0
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